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Abstract 
 

This article aims to reveal the systematic design of the website. Data 
were collected through observation and interviews with librarians. 
Data analysis was done descriptively. By analyzing the data, it was 
concluded matters as follows. (1) the design of websites using Adobe 
Dreamweaver CS3, (2) the information discussed in this paper about 
the website includes the steps of data collection by observation and 
interviews, process design websites with Adobe Dreamweaver CS3 as 
well as designing the header using applications Fireworks CS3 
Portable, and (3) description of the scope of information is divided 
into seven key menu consisting of, first menu Home (congratulations 
came from the head of the museum), the second menu Profile (history, 
organizational structure, staff and vision), a third menu News 
(activity library), fourth menu Album (photo collection), the fifth 
menu Services (facilities and service time), the sixth menu Information 
(information about the library), and the seventh Contacts menu 
(comments and suggestions). 
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A.  Pendahuluan 

Teknologi adalah penerapan keilmuan yang memepelajari dan 
mengembangkan kemampuan dari suatu rekayasa dengan langkah dan teknik 
tertentu dalam suatu bidang. Sedangkan informasi adalah data yang telah diproses 
ke dalam suatu bentuk yang mempunyai arti bagi si penerima dan mempunyai 
nilai nyata, sehingga dapat dipakai sebagai dasar untuk mengambil keputusan, 
bagi keputusan saat itu atau keputusan mendatang. Jadi teknologi informasi adalah 
hasil rekayasa manusia terhadap proses penyampaian informasi dari bagian 
pengirim ke penerima sehingga pengirim informasi akan lebih cepat, lebih lama 
penyimpanannya, dan lebih luas penyebarannya. 

Akar dari teknologi informasi pada masa sebelum ada komputer digital 
adalah telekomunikasi dan sistem audio-video. Kemudian dengan adanya 
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komputer digital telah membentuk beberapa cabang baru. Dengan adanya 
kemajuan-kemajuan teknologi, saat ini cakupan teknologi informasi yaitu; (1) 
telekomunikasi, penerapannya yaitu adanya teleconference; (2) komputer, 
termasuk mikrobentuk contohnya perlindungan data, sistem pakar, komunikasi 
suara dengan bantuan komputer; (3) jaringan digital, contoh adanya surat 
elektronik, sistem informasi, jaringan informasi; dan (4) audio dan video, termasuk 
sistem komunikasi optik, contoh video conference, dan video teks. 

Menurut Saleh (2010:120) World Wide Web adalah salah satu layanan yang 
didapat oleh pemakai komputer yang terhubung ke internet. Internet saat ini 
dianggap identik dengan website. Website ini menyediakan informasi bagi pemakai 
komputer yang berhubungan ke internet. Cara kerja website sebagai berikut; (1) 
informasi websitedisimpan dalam dokumen dalam bentuk halaman-halaman 
website atau web page; (2) halaman websitetersebut disimpan dalam komputer 
server web; (3) sementara dipihak pemakai ada komputer yang bertindak sebagai 
komputer clientdimana ditempatkan program untuk membaca halaman 
websiteyang ada di server web; (4) browser membaca halaman websiteyang ada di 
server web. 

Aplikasi website dapat dibagi dua menjadi dua kategori yaitu; (1) Website 
satis. Website statis adalah website yang berisi atau menampilkan informasi-
informasi yang sifatnya statis (tetap). Artinya, interaksi pengguna hanya sebatas 
informasi yang ada dan tidak bisa mengubahnya karena informasi tersebut hanya 
bisa diubah oleh administrator. Untuk mengetahui suatu websitebersifat statis atau 
dinamis dapat dilihat dari tampilannya. Jika website hanya berhubungan dengan 
halaman websitelain dan berisi suatu informasi yang tetap, maka website tersebut 
disebut statis. 

Dalam mendesain sebuah web, banyak hal yang harus diperhatikan. Tidak 
hanya memperhatikan tampilan-tampilan yang nyaman untuk dilihat, namun 
masih banyak juga unsur lain yang mendukung sebuah web. MenurutDarmansyah 
(2010:254) dalam mendesain sebuah webada beberapa yang harus 
dipertimbangkan yaitu; (1) kesederhanaan, meskipun kelengkapan pesan menjadi 
tujuan utama dalam web, tetapi juga harus menjaga kesederhanaannya; (2) 
konsistensi, menjaga agar tata letak halaman tidak membuat pengunjung 
menghabiskan waktu untuk mencari navigasi dengan tujuan menemukan jawaban 
atas pertanyaannya; (3) kejelasan, dalam mendesain sebuah webharus 
menggunakan bahasa yang diterima oleh pengguna; (4) keseimbangan, 
menyeimbangkan bentuk, ukuran dan warna pada web. 

Menurut Sutisna (2007:10) tujuan pembuatan website sangat beragam 
diantaranya sebagai berikut; (1) e-Commerce(pasar internet), Merupakan proses 
hubungan dagang atau bisnis untuk memudahkan pembelian atau penjualan antar 
perusahaan-perusahaan yang dilakukan di internet. Kegiatan e-Commerce yaitu 
belanja atau membeli sesuatu di internet dengan proses pembayaran 
menggunakan kartu kredit dan transfer; (2) alat pemasaran (marketing tools), 
website ini tidak menyediakan penjualan online, tetapi pengunjung diberi informasi 
untuk mendapatkan produk atau jasa yang dipromosikan; (3) e-learning, 
merupakan proses pembelajaran yang dilakukan secara online, yang tidak 
mengharuskan siswa bertatap muka dengan pengajar. Sekarang belajar berbagai 
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pengetahuan tidak hanya di bangku sekolah atau melalui buku tapi semua tempat 
bisa dilakukan sebagai tempat belajar dengan bantuan keberadaan website. 

Tipografi adalah karakter desain yang disatukan oleh anatomi visual. 
Tipografi dan huruf sering digunakan secara bersamaan, saling berganti tempat. 
Sedangkan huruf adalah satuan karakter komplit dalam satu desain, ukuran, 
bentuk atau tipe gaya. 

Jenis-jenis huruf yang biasa digunakan dalam mendesain websiteadalah 
huruf Sans Serif. Huruf Sans Serif memiliki ciri-ciri, yaitu tidak memiliki kait, hanya 
batang dan tangkai saja, sederhana dan akrab, sangat mudah dibaca, dan cocok 
untuk website, e-book, CD, tampilan desain monitor dan baik pula untuk tampilan 
televisi. Contoh huruf Sans Serif yaitu Arial, Switzeland, Tahoma dan Avant Garde. 
Kesan yang ditimbulkan oleh huruf jenis ini adalah modern, kontemporer dan 
efisien. Huruf ini digunakan karena terlihat lebih sederhana dan lebih mudah 
dibaca pada berbagai ukuran. 

Dari tujuh warna yang diperoleh dari representasi sinar putih dapat diperoleh 
ratusan warna lain. Pada dasarnya seluruh warna yang ada di dunia diturunkan 
dari tiga warna dasar yang biasa disebut warna primer. Dari warna primer ini 
dapat diperoleh kelompok warna lain, yaitu warna sekunder dan tersier.  

B. Metode Penelitian 
Metode yang digunakan dalam penulisan makalah ini adalah metode 

deskriptif dengan teknik pengumpulan data observasi langsung ke lapangan, 
wawancara dan kepustakaan. Observasi dilakukan dengan mengamati 
penelusuran informasi yang digunakan pada perpustakaan. Setelah melakukan 
pengamatan, langkah selanjutnya merancang poin-poin penting yang akan 
dicantumkan pada makalah serta halaman yang akan ditampilkan pada rancangan 
website.  

C. Pembahasan  
1. Langkah-langkah Pengumpulan Data/informasi dalam Rancangan 

Website di Perpustakaan Museum Adityawarman Padang 
 

Websiteperpustakaan merupakan media untuk memberikan informasi 
kepada semua orang tentang cakupan ruang lingkup perpustakaan ataupun yang 
tidak termasuk dalam ruang lingkup perpustakaan. Website perpustakaan 
dirancang dengan tujuan setiap orang mengetahui cakupan dalam ruang lingkup 
perpustakaan.  

Website perpustakaan yang akan dirancang menggunakan aplikasi Adobe 
Dreamweaver CS3. Adobe Dreamweaver CS3merupakan salah satu softwareyag 
didesain khusus untuk mendesain web. Program ini menyediakan fasilitas 
pembuatan melalui htmlmaupun desain instan menggunakan insert.  

Namun, sebelum melakukan perancangan websitePerpustakaan Museum 
Adityawarman Padang terlebih dahulu harus dilakukan pengumpulan data atau 
informasi yang kira-kira dibutuhkan oleh publik. Selain untuk melengkapi data 
bagi penulis, pengumpulan data atau informasi juga berguna untuk dimasukkan ke 
dalam pembahasan rancangan website. Adapun langkah-langkah pengumpulan 
data atau informasi tersebut adalah sebagai berikut. 
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a. Mengumpulkan ide atau gagasan pokok, 
b. Pengumpulan informasi berita Perpustakaan Museum Adityawarman Padang, 
c. Pengumpulan data/informasi mengenai koleksi di Perpustakaan Museum  

Adityawarman Padang, 
d. Pengumpulan informasi mengenai profil perpustakaan, 
e. Pengumpulan informasi mengenai layanan di Perpustakaan Museum 

Adityawarman Padang, 
2. Proses Rancangan Website sebagai Media Informasi di Perpustakaan 

Museum Adityawarman Padang  
 

Perpustakaan Museum Adityawarman belum mempunyai website sendiri. 
Websiteyang akan dirancang, dibuat sebagai media untuk memberikan informasi 
mengenai layanan dan koleksi Perpustakaan Museum Adityawarman Padang 
kepada publik. Program yang digunakan untuk merancang websiteadalah Adobe 
Dreamweaver CS3. Adobe Dreamweaver CS3merupakan aplikasi yang didesain 
khusus untuk mendesain website. Software ini menyediakan fasilitas pembuatan 
melalui html maupun desain instan menggunakan insert. 
 

 

 

 

 

 

 

 

 

 

 

Gambar 1 
Tampilan Dasar Website 

Dalam pembuatan website akan melalui 3 tahapan yang harus dilakukan, 
yaitu; 1) membuat header; 2) membuat sitewebsite; dan 3) membuat halaman dan 
menu website. 

 
1. Membuat Header  

Untuk membuat header-nya yaitu pada softwareFireworks CS3 Portable. 
Fireworks CS3 Portablemerupakan sebuah bitmap dan victorgrapichs editor. 
Fireworks dibuat untuk webdesigner agar membuat prototypewebsite dan 

Header 

Beranda Profil Berita Album Layanan Informasi kontak 

Jadwal buka 

perpustakaan 

Kontak 

Foto koleksi 

Foto museum 

Footer 
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applicationinterface dengan cepat. Fiturnya memasukkan slices dan kemampuan 
untuk menambahkan hotspot. Fireworks didesain untuk diintegrasikan dengan 
produk adobedreamweaver. 

 
Gambar 2 

Tampilan Header 
2. Membuat Site Website 

Untuk membuat sitewebsite, langkah-langkah yang dilakukan adalah. 
a. Buka program Dreamweaver caranya Start>All Program>Adobe 

Dreamweaver CS3> Ok. 
b. Klik menu Site > New Site. Kemudian isikan dengan nama situs yang 

diinginkan pada site name, langkah selanjutnya klik next. 
c. Sesudah site name dilanjutkan maka akan tampil, tampilan seperti dibawah 

ini. Kemudian klik next lagi. 
d. Selanjutnya mengisi alamat folder dimana file website disimpan. Seperti 

gambar dibawah ini. Kemudian klik next. 
e. Mengubah  server dengan none karena penulis tidak menggunakan database 

dalam rancangan website ini. Maka akan muncul tampilan seperti dibawah 
ini. Kemudian klik next. 

f. Sesudah  klik next, maka akan muncul tampilan seperti dibawah ini 
kemudian klik done. 

g. Langkah berikutnya setelah tombol done diklik maka akan muncul tampilan 
seperti di bawah ini. 
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Gambar 3 

Tampilan Site yang sudah selesai Dibuat 

3. Membuat Halaman dan Menu Website 
Selain mendesain header, dan membuat sitewebsite juga perlu membuat 

halaman dan menu websitemerupakan tahap utama untuk membuat 
linkwebsite. Yang harus dilakukan dalam membuat halaman dan menu website 
sebagai berikut.  
a. Klik kanan pada nama site yang sudah dibuat, kemudian klik new file dan 

isikan pada file tersebut nama sesuai dengan keinginan, tetapi nama file 
tersebut harus dibuat dengan HTML misalnya (Index.html). Setelah nama 
file tersebut selesai dibuat maka langkah selanjutnya harus menekan enter 
pada keyboard, dan selanjutnya file yang sudah dibuat tadi dibuka dengan 
cara mengklik doublefile. 

b. Sesudah tampilan awal untuk mendesain website muncul,  penulis harus 
mengklik icon table, dan membuat berapa jumlah tabel dan baris yang 
diinginkan. Jumlah baris diisikan pada Rows dan jumlah kolom diisikan 
pada Colums. Tahap selanjutnya menentukan lebar table terhadap halaman. 
Jika diinginkan lebar table dalam satuan pixel, maka isikan jumlah pixel 
pada width. Kemudian klik tombol Ok . 

c. Setelah table muncul pada halaman websitetabeldibuat ketengah halaman 
website agar nantinya tampilan websiteterlihat bagus. Untuk menjadikan 
halaman website ketengah harus ganti kotak yang bertuliskan align dengan 
center. 

d. Setelah tabel muncul selanjutnya penulis harus menghilangkan kolom. 
Untuk menghilangkan kolom pada bagian header, tombol dan footer 
caranya adalah dengan memblok  baris pertama pada sebelah kiri 
kemudian tekan Ctrl>Alt>M. 

e. Setelah menghilangkan kolom, barulah memasukkan header, cara 
memasukkan header nya yaitu letakkan cursor pada baris pertama, lalu klik 
menu insert>image, akan tampil menu dialognya, cari file gambar dengan 
nama yang telah disimpan sebelumnya contohnya untitled-1 lalu klik Ok. 
Setiap image yang dimasukkan ke dalam kolom harus disimpan agar tidak 
hilang dan imageselalu muncul pada saat dibuka. 
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f. Mengisi footer, bagian footer terletak pada baris terakhir. Caranya adalah 
Pindahkan lagi kursor pada baris keempat untuk mulai mengisi footer. 
Untuk membuat footer ketengah ganti kotak yang bertuliskan Horz dengan 
Center, dan untuk membuat footer kebawah maka tekan Shift>Enter. 
Biasanya informasi yang akan diisikan adalah alamat lengkap Perpustakaan 
Museum Adityawarman serta nomor telepon dan fax perpustakaan. setelah 
sama dilakukan maka tampilan footer 

g. Membuat Tombol Menu 
Membuat tombol menu merupakan langkah lanjut untuk membuat 

website. membuat tombol menu dapat dilakukan dengan cara meletakkan 
kursor pada baris kedua. Buka code setelah itu tulisan yang hitam dibawah 
codeheaderdihapus. 

Kemudian copycode menu yang terletak pada Notepad setelah itu 
paste pada code yang sudah dihapus. Notepad adalah sebuah bahasa 
penyunting teks dan penyunting kode sumber yang berjalan di sistem 
operasi Windows. Notepad menggunakan komponen Scintilla untuk dapat 
menampilkan dan menyunting teks serta berita kode sumber dari berbagai 
bahasa pemrograman. Pada notepad banyak bahasa pemrograman yang 
bisa digunakan, diantaranya CSS, HTML, PHP, JavaScript dan lain 
sebagainya. Software notepad digunakan oleh banyak orang untuk berbagai 
keperluan. 

Kemudian buka Designklik kanan Name Site>New File, setelah itu 
buat nama file tersebut dengan akhir kata CSS misalnya gustia.cssdan tekan 
tombol enter pada keyboard, cascading style sheet merupakan aturan untuk 
mengendalikan beberapa komponen dalam sebuah web sehingga akan lebih 
terstruktur dan seragam. 

Copy kode CSS yang ada pada Notepadkemudian paste pada folder 
yang sudah dibuat tadi (gustia.css) kemudian simpan Ctrl>S. 

Langkah selanjutnya klik codekemudian lihat code yang paling atas 
beri enter dibawah tulisan berikut <title>Untitled Document</title>. 
Kemudian copy link yang ada pada notepad, kemudian paste pada tempat 
code yang sudah diberi enter. Tulisan template.css ditukar sesuai dengan file 
yang dibuat yaitu file gustia.cssdan disimpan ctrl>s. kemudian buka design 
maka tombol akan tampil seperti gambar dibawah. Selanjutnya sesuaikan 
ukuran header dengan table begitu juga dengan tombol menu. 

h. Membuat Tampilan Awal Website 
Tampilan awal website biasanya berisi tentang informasi yag bersifat 

umum seperti jadwal buka dan tutupnya perpustakaan. untuk membuat 
tampilan awal website dapat dilakukan dengan cara meletakkan kursor 
pada baris ketiga pada kolom kedua, lalu pada properties pilih bagian 
Vert>Top. Top gunanya adalah agar tulisan yang dibuat berada di sebelah 
atas dan pilih bagian Horz>Center. Kemudian tekan tombol Shift+Enterdi 
keyboarduntuk pindah baris, penulis menuliskan PERPUSTAKAAN 
MUSEUM ADITYWARMAN PADANG. Untuk baris selanjutnya untuk 
pengisian gambar caranya sama seperti sebelumnya, klik Insert>Image 
untuk memasukkan gambar museum yang tersimpan pada folder image. 
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Ditampilan awal website tidak hanya terdapat gambar saja namun 
penulis juga memasukkan jadwal buka perpustakaa pada kolom pertama 
baris ketiga untuk pengisian teks diperlukan table. Untuk memasukkan 
table caranya sama seperti sebelumnya. Letakkan kursor pada baris yang 
akan diisi table, klik Insert>Table isi ukuran Table>Ok. Agar garis table tidak 
kelihatan maka harus diklik border dengan ukuran nol dan ubah lalu pada 
kotak align pilih center agar table tersebut terlihat bagus. Pada kolom ketiga 
pada baris ketiga penulis membuat koleksi perpustakaan. 

i. Selain tampilan awal website yang harus diperhatikan namun ada hal 
penting yang harus ada dilakukan yaitu membuat daftar tombol navigasi., 
yaitu klik kanan name site kemudian klik new file cara yang dilakukan ini 
sama dengan cara sebelumnya. Misalnya Berita – file : berita.html dan 
begitu seterusnya untuk semua tombol navigasi yang dibuat pada website. 
Ini dibuat agar penulis langsung bisa memasukkan  data-data yang ingin 
dimasukkan sesuai dengan tombol navigasi. 

j. Setelah semua halaman websiteselesain didesain dan disimpan pada folder 
yang telah ditentukan, langkah selanjutnya, yaitu membuat link yang 
merupakan cirri khas dari dokumen website. link adalah sebuah teks atau 
gambar yang bila diklik akan membawa pengguna kebagian lain dari 
dokumen website. sebuah link biasanya ditandai dengan teks warna biru 
bergaris bawah atau pointer mouseyang berubah menjadi telunjuk tangan. 
Dalam pembuatan website ditemukan beberapa kendala, diantaranya 

menemukan script yang telah didapatkan karena terkadang script tidak berjalan 
sesuai dengan yang diharapkan dan menentukan warna yang cocok untuk website. 

Setelah website selesai, maka langkah yang harus dilakukan adalah 
menampilkan seperti website benar-benar online. Untuk melihat hasil web yang 
telah selesai dibuat maka ditampilkan melalui program Mozilla firefox. Akhir dari 
sebuah halaman web, yaitu sebagai berikut. 
a. Sebelum menjalankan web di lokal server pastikan file sudah tersimpan 

dengan nama yang telah ditentukan. File tidak akan bisa dibuka apabila nama 
file diubah. 

b. Untuk melihat hasil web jalankan web browser dengan perintah 
file:///C:/Users/Axioo/Desktop/Index.html, web akan tampil di monitor. 
Selama tidak ada kesalahan pada pendefinisan web dan penamaan file, tombol 
navigasi akan berjalan sesuai harapan dan semua image akan muncul. 
Halaman web tidak terjadi broken link dan web tampak lebih indah seperti 
website yang online. 

file:///C:\Users\Axioo\Desktop\Index.html
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Gambar 4 
TampilanWebsite 

D. Simpulan dan Saran  
Berdasarkan pembahasan yang telah dijelaskan pada Bab Pembahasan 

sebelumnya, maka dapat penulis buat beberapa simpulan yaitu; 1) rancangan 
website menggunakan aplikasi AdobeDreamweaverCS3; 2) langkah-langkah dalam 
rancangan websiteyaitu; membuat header, membuat sitewebsite dan membuat 
halaman dan menu website; 3) desain headerwebsite dirancang menggunakan 
aplikasi FireworksCS3Portable; dan 4) dengan adanya media informasi online 
berbasis website akan memudahkan pengguna. 

Website Perpustakaan Museum Adityawarman terdiri dari tujuh tombol 
menu yang terdiri dari, menu pertama Beranda (ucapan selamat datang dari 
kepala museum), menu kedua Profil (sejarah, struktur organisasi dan staff), menu 
ketiga Berita (kegiatan perpustakaan), menu keempat Album (foto koleksi), menu 
kelima Layanan (fasilitas dan waktu layanan), menu keenam Informasi (informasi 
tentang perpustakaan), dan menu ketujuh Kontak (kritik dan saran).  

Berdasarkan kesimpulan sebelumnya maka saran penulis untuk 
Perpustakaan Museum Adityawarman Padang ialah agar menggunakan website 
sebagai media informasi koleksi Perpustakaan Museum Adityawarman Padang. 

Adanya website ini diharapkan dapat meningkatkan citra positif di 
Perpustakaan Museum Adityawarman Padang. Website merupakan media 
informasi dengan cakupan yang luas, dan dapat diakses 24 jam oleh publik serta 
informasi yang tercantum didalamnya dapat di update dengan cepat serta tidak 
membutuhkan biaya yang mahal. Diharapkan dengan adanya website, informasi 
perpustakaan akan lebih mudah dilakukan.  
 
Catatan: artikel ini disusun berdasarkan tugas akhir penulis dengan Pembimbing 

Elva Rahmah, S.Sos., M.I.Kom. 
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